Composer HE Getting Started
Control4 OS 2.10
Legal notices

Control4 disclaimer
Control4 makes no representations or warranties with respect to this publication, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Control4 reserves the right to make changes to any and all parts of this publication at any time, without any obligation to notify any person or entity of such changes.

Legal notice

GNU
GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION (Section 3.b.)
You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:
Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 on a medium customarily used for software interchange.
The complete text for this license is available on the Control4 web site at: http://www.control4.com.

Gracenote
Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either a registered trademark or a trademark of Gracenote, Inc. in the United States and/or other countries.
Music and DVD recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. For more information visit www.gracenote.com.

MPEG
Fraunhofer IIS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. Supply of this product does not convey a license nor imply any right to distribute content created with this product in revenue-generating broadcast systems (terrestrial, satellite, cable, and/or other distribution channels), streaming applications (via Internet, intranets, and/or other networks), other content distribution systems (pay-audio or audio-on-demand applications, and the like) or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards, and the like). An independent license for such use is required. For details, visit http://mp3licensing.com. Radio Locator is the service provider of AM/FM channel list.

Spread
This product uses software developed by Spread Concepts LLC for use in the Spread toolkit. For more information about Spread see http://www.spread.org.

All Media Guide
© 2005-2008 All Media Guide, LLC provides music and video recognition technology that provides cover art and related text that enriches the Control4 user Navigators.

Copyright
Copyright ©2016, Control4 Corporation. All rights reserved. Control4, the Control4 logo, the 4-ball logo, 4Store, 4Sight, Control4 My Home, and Everyday Easy are registered trademarks or trademarks of Control4 Corporation in the United States and/or other countries. All other names and brands may be claimed as the property of their respective owners. All specifications subject to change without notice.
No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

Contact information
Control4 Corporation
11734 S. Election Road
Salt Lake City, UT 84020 USA
www.control4.com
Part number: 200-00169-S
Composer Home Edition Getting Started (OS 2.10.0, 9-5-2017 DH)
Contents

Legal notices .................................................................................................................2
Contents ......................................................................................................................... 3
Introduction .................................................................................................................. 5
  What you can do in Composer HE ..............................................................................5
  For more information .................................................................................................6
  What’s new? ..................................................................................................................6
    Hardware and software support ..........................................................................6
Getting started ......................................................................................................... 7
  Important basics ....................................................................................................... 7
  Overview .................................................................................................................... 9
Installing Composer HE ............................................................................................. 9
  System requirements ............................................................................................9
  Install the software ...............................................................................................10
Starting Composer HE ...............................................................................................11
  Before starting Composer HE ................................................................................11
  Start Composer HE ...............................................................................................11
  Startup options ......................................................................................................12
  Connect to a Director ............................................................................................13
Exiting Composer HE ..................................................................................................17
Exploring the interface ..............................................................................................17
  Views ..........................................................................................................................18
    Monitor and control lights, thermostat, etc. (Monitoring view) .........................18
    Manage digital music and DVD collections (Media view) ..................................21
    Use intelligent agents (Agents view) ..................................................................23
    Program the Control4 system (Programming view) ..........................................25
    Menu options ....................................................................................................29
    File .........................................................................................................................29
    Media ......................................................................................................................30
    Tools ......................................................................................................................30
    Help .......................................................................................................................33
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where to go from here</td>
<td>33</td>
</tr>
<tr>
<td>Glossary</td>
<td>34</td>
</tr>
<tr>
<td>Index</td>
<td>37</td>
</tr>
</tbody>
</table>
Introduction

Control4® Composer Home Edition (HE) is powerful software that lets you customize your Control4 system. This Windows-based program that has an intuitive drag-and-drop interface that lets you view and configure your devices, manage your media, and create simple home automation programs.

Your Control4 Dealer has installed and configured your Control4 system using the professional version of Composer. Composer HE was created just for you.

This document provides you with a brief overview of how to run the software. For more detailed information, see the Composer HE User Guide.

In this document, you’ll learn how to:
• Install Composer HE
• Start and close Composer HE
• Connect to a Director
• Begin to use the Composer HE interface
• Review the views and menu options

What you can do in Composer HE

Using Composer HE, you can program your Control4 system to behave as you want it to by tying together your system’s devices into a single, controllable environment.

Customize your system

Customize your system from a Windows PC on your home’s local network or, if you have a Control4 4Sight subscription, from any Internet-connected Windows PC.

Monitor and control

From your Windows PC, monitor:
• Dimmers, switches, and keypads
• Wireless thermostat and security system
• Many other devices

Configure Control4 devices

• Set LED colors on lights and keypads
• Set the dimming speeds and default brightness of wireless dimmers
• Set your Control4 Wireless Thermostat schedule
• Program the buttons on your Control4 System Remote Control.

Manage your digital music and DVD collections

Scan your media libraries for new additions so they become available to your Control4 audio devices.
Configure your system using intelligent agents

- Tie together the audio source selection, volume control, and on/off state of multiple rooms so that they work as one.
- Configure the system to notify you when system events happen.
- Create an announcement that displays on system Navigators.
- Create and modify custom lighting scenes.
- Program events based on date, time of day, and sunrise/sunset. You can also create your own Wakeup scenes.
- Create custom programming scripts.
- Do much more. For more information, see “Agents” later in this guide.

Limitations

Although Composer HE lets you customize your Control4 system, some advanced tasks and configurations must be done by your Control4 Dealer. Your dealer can also help you if you have difficulty using Composer HE.

If your system has been configured to connect to Control4’s 4Sight service, your dealer can perform many of these services over the phone and on the web without having to schedule a service call at your home.

Contact your Control4 Dealer if you ever need to:

- Create a new Control4 system or add/remove devices
- Create or edit drivers for third-party products
- Install updates to system software
- Perform other tasks (such as complex programming) that are beyond the capabilities of you or the software

For more information

You can find the following related help at ctrl4.co/cdocs.

- Control4 System User Guide (ctrl4.co/userguide)
- Instructional videos

What’s new?

Hardware and software support

New

- Support for new hardware products including Triad Audio Matrix Switches, Triad Power Amplifiers, Triad One Streaming Amplifier, Control4 DS2 Mini, ZigBee IO, and ZigBee Contact.
- New Identity agent for System Manager Web and When >> Then logins
- New Navigation agent for programming an automatic change to a Camera view
End-of-life products

- Blocked from being in an OS 2.10 project: HC-200, HC-300, HC-500, and HC-1000
- Drivers and agents that must be updated before updating to OS 2.10: In-Wall 7” TS V2, Portable 7” TS V2, InfinityEdge 7” TS, InfinityEdge 5” TS, and Control4 Door Station drivers using the Intercom agent. These drivers must be updated to the versions compatible with the Communication agent.
- Products that can be in an OS 2.10 project, but will not receive an update: 7” In-Wall v2, 7” Portable v2, Exterior Door Station, Interior Door Station, IO Extender, 5” In-Wall (FKA: Infinity Edge), 7” In-Wall (FKA: Infinity Edge), 7” In-Wall RevB (FKA: Infinity Edge). These items may not be compatible with every feature in OS 2.10, including Intercom.

Getting started

Important basics

Your Control4 Dealer or installer has installed and configured your Control4 system to your specifications based on your purchase agreement. While individual Control4 Dealer policies may vary, most dealers will charge you for additional service calls unless you have a service contract.

One of the benefits of using Composer HE is that you can customize parts of the Control4 system yourself, which can save you money. Should you require your dealer’s help, however, you must be prepared to pay for that help. Check with your dealer for details.

Caution! When using Composer HE, you are configuring your own Control4 system. While this gives you a great deal of capability, it also carries some risk for which you must be prepared to take responsibility. If you disable your system, your dealer may need to fix it for you, and this could cost you extra.

This section describes some of the basic principles of using Composer HE on your Control4 system. It’s important to understand these principles and accept the risk and responsibilities that come with customizing your system yourself.

1. Your system may become inoperable due to certain types of changes you can make using Composer HE. It’s possible that you could make your system inoperable using Composer HE. In most cases, you can recover your system using a backup project file. However, if you can’t recover your system using a backup project file, contact your dealer for help. Your dealer can often restore your system back to an operational condition.

2. There is no ‘Undo’ capability, so back up your project frequently. If you make a change you don’t like, there is no way to easily "undo" that change. You can try to change the settings back to the way they were (if all changes were carefully documented), but the easiest way to restore your system is to load a backup copy of the project that you previously saved. Whenever you make changes to your project, we strongly recommend making a backup copy. To save your project file, use the Back Up option under the File menu. To save a backup copy, use Back Up As and specify an alternate filename (it’s good practice to include the date in the backup filename). When you load a backup file, however, remember that you’ll lose any customization that’s happened since the backup file was created.
3 **Changes you make in Composer HE are immediately applied to your system.** When you connect to Director and customize your system, the changes are effective immediately. Whether you’re changing LED colors or dimmer ramp rates, performing complex programming or using agents, Director immediately modifies your system configuration.

4 **Programming can be associated with multiple events.** You can program your system to perform similar tasks in a variety of ways. For example, you can set the LED color as a device property, and you can change that property in programming, too.

    **Note:** Pay close attention to your programming changes so that you don’t inadvertently change the behavior of your system in an undesirable way.

5 **Project files can be backed up with and without the media database.** When you back up your project file, you can create the backup with or without the media database information. If you load a project file that doesn’t have any media associated with it, you will lose the media database information that was associated with your current system. It’s always a good practice to back up your project with your media when you exit Composer so if you ever need to restore your system, your media database will still be intact. You can also export the media database information and playlists separately for each media source on your Control4 system. If you import your media database and playlists, the current media list for that media source and the current playlists will be cleared and replaced with the media database in the file you are importing.

    **Tip:** If you forget to back up your media, you can always go back to a previous backup with the media loaded. This may, however, change your system configuration to the old configuration in that backed up project.

6 **Backups with media and exported media lists only include the media database information.** Backups and exported media lists contain only the media database information used by the Control4 system, not the actual media files. To back up the media files, you should separately back up the media source files to a mass file storage location (USB drive, network file storage, or cloud storage) after exiting Composer HE.
Overview

The following illustration shows how a small home network might be set up. The laptop shows the Control4 Composer HE software installed on it. Your installer may have set up a network similar to this one.

The router is the heart of your home computer network. It uses a modem to communicate with the Internet. The router provides wifi that wireless devices (such as laptops and smart phones) can use to connect to the network and the Internet. The switch provides additional wired connections to the home network.

The Control4 controller is the heart of the Control4 home automation network. Your Control4 network is attached to your home computer network. To change how your Control4 network works, you need to:

- Install the Composer HE software onto a computer that’s connected to your home network.
- Run Composer HE and connect to the Director software on the Control4 controller. After you’ve connected to the Control4 Director, you can see the Control4 devices, settings, and programming that automates your home.

Installing Composer HE

System requirements

Computer software and hardware

- Microsoft.NET 4 (the Composer HE installation is launched automatically from the Control4 website).
- Microsoft Windows 10, 8, 7, or Vista operating system. Mac support when used with a Windows virtual machine such as Parallels or VMWare Fusion for Mac.
- 500 MHz or higher processor
- 256 MB RAM
• 90 MB available hard disk space
• Video card and monitor supporting a resolution of 1024x768 or higher
• Keyboard
• Mouse

Home computer network
• Wireless access point (WAP) or wireless router that supports 802.11b/g/n (optional)
• TCP/IP-based (Ethernet) home network. This usually includes a network gateway, router, or switch.
• A broadband Internet connection. During initial setup, a broadband Internet connection is required to update the Control4 system and retrieve the media's cover art. Also, a broadband Internet connection is required to support remote access to the system.

Control4 home automation network
• A Control4 controller
• Control4 Composer Home Edition (Composer HE) software, version 2.10.0
• A valid electronic license to run Composer HE.

Install the software

Tip: We recommend that you install Composer HE on a PC laptop or tablet. Laptops and tablets are very handy to move about the home or business as you set up your project and test your devices.

To Install Composer HE:

1. Download and run the installation program from the URL provided to you by your Control4 Dealer or installer. The Installation link contains the Composer HE software and this Composer HE Getting Started as online help (a PDF of this guide is available on the Control4 website). The Composer HE User Guide (the companion to this document) is available on the Control4 website in web help or PDF formats.

2. Click Install Composer.

3. Follow the on-screen instructions to continue installing.

4. When prompted by the installation program, click continue anyway to install the Remote Access Network Tunnel Adapter on your computer.

5. When the installation completes, click Finish. A Composer HE icon displays on your PC desktop if you selected to have it installed there.

Tip: The Start menu (Programs > Control4 > Composer 2.10.0 > Composer Directories) has folders for the Drivers, Logs, and Projects in your system. For quick reference, you may want to refer to these folders from time to time.
Starting Composer HE

Before starting Composer HE

Prerequisites

Before you start Control4 Composer HE, you or your installer need to:

- Create your Control4 account at customer.control4.com.
- Register your controller to your project so it works with the system.
- Set up Remote Access so your dealer can fix any problems remotely.
- Set up 4Sight for remote access to the system.
- Log in to your account at customer.control4.com and make note of your Composer HE subscription code.

Note: This setup may have already been done for you by your Control4 Dealer. If you don’t know whether this setup is complete, check with your dealer to either verify it’s been done or get your account information (account name, email address, password, and registration code.)

The first time you start Composer HE, the system prompts you for your Control4 account information and a Composer HE subscription code. 4Sight is a Control4 service that lets you receive email notifications or control the system remotely using your smartphone, tablet, or PC.

To use a 4Sight Internet connection, email agent, and Anywhere Access services for one year, you may use the one-year 4Sight subscription included with each copy of Composer HE. Thereafter, you can purchase an annual 4Sight subscription from your Control4 Dealer so you can continue to enjoy its benefits.

Start Composer HE

To start Composer HE:

1. From the Start menu, click All Programs. Control4. ComposerHE. Composer HE starts and opens a window for connecting to a Director.
The first time you start Composer HE, however, an activation window opens first.

a Enter the subscription code provided with your Composer HE software. You can also log in to your account at customer.control4.com and click My Software to see your subscription codes.

Your Composer HE subscription code will be four 4-character sets separated by dashes, such as xxxx-xxxx-xxxx-xxxx.

b Enter the email address and password associated with your Control4 account at customer.control4.com.

c Click Activate. The startup screen appears.

Each time you start Composer HE, you will connect to your Control4 system either locally (click Local System) or remotely (click Remote System). See “Startup Options” and “Connect to a Director” for more details.

2 On the Control4 system, the primary controller is the controller (and Director) that you connect to from your PC.

Note: To connect to a Remote System, first you must set up remote access. See “Error! Reference source not found.”.

Startup screen:

Startup options

Ensure that you’ve registered and activated your account before you start Composer HE for the first time. See “Before starting Composer HE” on page 11.
When you start Composer HE, the startup screen presents these connection options. See “Connect to a Director” for details.

- **Local System**—Select this option when working while connected to the home network (inside the firewall). You can modify the project, make connections, add media, and program the system.

- **Remote System**—Select this option when working remotely, but connected to a home network from the Internet (outside the firewall). You can change your Control4 system as if you were connected to the local network (second option). This requires Remote Access. See “Error! Reference source not found.” on page Error! Bookmark not defined.

### Connect to a Director

Control4 controllers have embedded Director software within the controller. Director controls the communication of devices and allows the automation of your Control4 system. When you connect to a Director, you can define and customize your project for your system.

Composer HE lets you access and change your project configuration. When you want to change your project to reflect how you want your Control4 system to behave, you connect to a Director using either a local connection or a remote connection.

This section describes how to:

- Connect to a local Director
- Connect to a remote Director
- Grant access to a dealer for Remote Access

### Prerequisites

- Ensure that you set up your account at customer.control4.com.
- Ensure that you have the correct setup, depending on how you want to connect. You can connect to Director two ways:
  - **Local System**. Your PC must be on the same IP-based local-area network as your Control4 system.
  - **Remote System**. Your Control4 system must be configured to use 4Sight Remote Access.

**Note:** A “Renew Composer Registration” message may appear before you can connect to Director. If it does, type your email address, password, and then click **Renew**.
Connect to a local Director

To connect to a local Director:

Connecting to a Director on the local network lets you configure settings, download a new project, or back up an existing project to a file on the computer. Every Director has an associated network address.

When you start Composer and connect to a local Director, you are making “live” changes to the hard drive on the controller, and every time you connect to that Director, you will see your project’s configuration.

1  Start Composer.

2  Click Local System. The Directors dialog appears.

Options available on this page:

- **Connect**—Connects to the selected controller on the local network. The main window shows the controller’s name and network address.
- **Cancel**— Cancels and closes the Directors dialog box.
- **Add**—Opens a dialog box that lets you add the network address of the controller to which you are trying to connect.
• **Remove**—Removes the selected controller from the *Directors* list. Select the controller to remove. Click **Add** to add it to the list again.

• **Refresh**—Updates the *Directors* list to display recently added Directors and scans the local network for any controllers running Director.

3 From the *Directors* list, select the IP address of the Director to access, and click **Connect**. The main page appears with the *Monitoring* and *List View* panes.

The following screen displays when you first start Composer HE:

**Composer HE main screen**

---

**Grant access to a Control4 Dealer**

**To grant access to a Control4 Dealer:**

1 To grant your Control4 Dealer access to your Control4 system, give the dealer access on your user list at [customer.control4.com](http://customer.control4.com).

   **Note:** Granting a dealer remote access rights to your account does not require that either you or the dealer reveals any confidential passwords.

2 On the Internet, go to [customer.control4.com](http://customer.control4.com), enter your email address and password, and then click **Submit**.

3 When you access your account screen for the first time, follow the on-screen prompts to enter your 4Sight Subscription Code, and then click **Activate**.

   **Note:** The 4Sight Subscription Code is a series of digits. Find this code on the card you received when you purchased your Control4 4Sight Subscription.

4 When successfully activated, you will see an *Account Subscription* confirmation screen. The screen shows the information you used to activate your remote account. When you finish reviewing the confirmation screen, click **OK**.

5 If you are connected to Anywhere Access, click **Cancel** or **Close**.

6 In the *My Account* view with *Account Administration* selected (left pane), click the **Profile** link, and verify the *Dealer of Record* information.

7 With *Account Administration* still selected, click the **Users** link.
8  At the bottom of the page, check this option: **Allow your dealer [your dealer’s name] to remotely access your system.**

9  To continue and connect remotely, follow the next set of instructions below.

Connect to a remote Director

To connect to a remote Director:

When you connect to a remote Director, you are making live changes to a controller remotely. Changes will be made over an Internet connection instead of a local network connection.

**Note:** This type of connection is not available until the initial configuration and controller registration is complete. Contact your dealer or see “Register your controller” in the Composer HE User Guide.

**Note:** You may revoke access rights to Control4 Technical Support or your Control4 Dealer using customer.control4.com at any time. This is not recommended, however, as it will interfere with needed regular updates.

1  Start Composer.
2  Click **Remote System**.

3  When your system is configured and registered to your Control4 account, connect to it using Composer HE from any Internet connection by entering your **Account Name**, **Email Address**, and **Password**.

4  When the **Account Name** dialog box appears, enter your email address and password, then click **Connect**. The account name will appear in the list.
   a  If the account name does not appear, click **Add** to add the account name, then click **OK** on the dialog box that appears. This is the account name you created during registration at customer.control4.com.
   b  When the **Select Remote Account** dialog box displays again, highlight your account, then click **Connect**.

A screen appears indicating that your account, email address, and password are being verified, which may take several minutes to complete. When authenticated and connected through the Remote Access service, the list of Directors available for connection displays.

5  Select the Director you want to connect to, then click **Connect**.
6  When the remote connection is established, Composer HE opens in the **Monitoring** view. Composer HE functions normally as if you were connected to a local Director, allowing you to configure, program, and troubleshoot your system.
Exiting Composer HE

To exit the Composer HE application, click **File > Exit**. The software asks you if you want to save a backup of the project file. Click **Back Up** or **Back Up As** to save the project. We recommend that you back up any changes you make to your project.

Exploring the interface

The Control4 Composer HE interface and wizards are designed to help you:

- Monitor your Control4 system.
- Maintain your media.
- Add or modify custom programs.

To take advantage of the Composer HE features, learn about the following options in Composer:

- Views
- Menu options

The Control4 Composer HE interface is divided into several panes.

**Composer HE main screen:**

The menu bar (**File**, **Tools** and **Help**) appears at the top of the window.

The upper left portion of the screen displays a project tree and all views available in your system with the floors, rooms, and devices you will define depending on what you want to do. In the project tree, you can click to collapse or expand the floor, room, or device levels.
The lower left portion of the screen shows the view buttons (Monitoring, Media, Agents, and Programming). This is where you create automated tasks for your system.

Views

Composer HE has four main views. If you click on a view button, the appearance and functionality of the interface changes to reflect the configuration options available for that view.

- **Monitoring**—Click to view the devices on your system, to access specific device controls, and to configure the properties of devices.
- **Media**—Click to manage your digital music, movies, and other collections from a disc player, DVD or CD player, etc. Add and scan stored or broadcast media.
- **Agents**—Click to configure an intelligent agent. Use agents in the system and in programming. Agents include Wakeup, Scheduler, and more.
- **Programming**—Click to create and modify custom programming for your system. Program devices and agents on the system.

**Tip:** Collapse the views by clicking and pulling down the dotted bar above the view buttons, giving you more room to view the project tree above.

**Note:** The project tree was created for you by your Control4 Dealer or installer and reflects the floors, rooms, and devices in your home or business. If the project tree doesn’t display, check with your Control4 Dealer.

Monitor and control lights, thermostat, etc. (Monitoring view)

The *Monitoring* view lets you view all of the devices and their current state.

This view:

- displays a list all of the devices in a room,
- displays the current state of contact inputs or other devices, and
- lets you monitor and control the devices contained in the selected location of the project tree.

When selecting a site, building, floor, or room, you can see all devices associated with each other in that area. If you select a device in the project tree, this view shows all devices that are in the same room.

**To use the Monitoring view:**

1. Click the *Monitoring* view in the Composer HE main window. Two pages in this view show the *List View* screen, which gives you status information for all system devices at a glance: *List View* and *Properties*. If the Control4 system is controlling/monitoring device power, the device is shown as red when off, and green when powered on. The light level, temperature, security system status, and other details are also shown on this screen.
2 Double-click any device in List View to display the controls associated with that device.

3 Click the Properties tab to access the Properties pane for all system devices. Select the device you want to change from the project’s tree view. For example:
   - Configure the LED colors on your keypads.
   - Configure the LED colors, ramp rates, and preset level for your dimmers.
   - Configure/program the programmable buttons on your System Remote Control for each AV device.
   - Configure/program the thermostat and its schedule.
Project tree (left pane)

The Monitoring view displays the project tree, a hierarchical display of locations and devices. The project tree is where all of the device drivers for your devices reside in your project. Double-click on a device to access its device controls. Hover over a device for detailed device information.

Monitoring pane:
Device control window

Access a device control window for supported devices by double-clicking the device in the project tree (Monitoring view). For example, if you select Left Dimmer in the project tree under Living Room, the following device control screen displays.

Device control:

The device control screen:

- Lets you test and control a device (after the device has been configured by your dealer) from Composer HE.
- Provides you with a simple user interface for device control. For example, the device control for a dimmer lets you click a button on the screen to turn the dimmer on and off or change the light level. This is helpful for testing.
- Lets you temporarily change the configuration and control a device from Composer HE. Later, you can set the configuration permanently in the Properties pane or Programming view. For example, you can adjust the ramp rate of a dimmer to determine the desired ramp rate to set during programming.

Manage digital music and DVD collections (Media view)

The Media view lets you:

- Add and scan your media selections to the system, including stored music and movie collections or broadcast channels and stations. In Media view, the left-side selections change the right-side views.
- View and select stored or broadcast media from the Navigators (including on-screen Navigator, System Remote Control, or touch screens that come in a variety of sizes).
- Set up playlists (playlists can be created at the Navigators). When you create or edit a playlist, you can pick albums or tracks to play. Control4 playlists have a limit of 500 songs.
- Search for cover art (when not loaded automatically) to enhance displays.
To manage your multimedia sources:

1. Click the Media view. The media source devices display.

Media view:

This list provides the media types for the Stored and Broadcast Media categories:

- **Stored Media**
  - CDs—Store CD cover art, albums, artist ratings, and genres (for example, Rock or Country).
  - DVD player or disc changer—Store DVD and CD (when DVD player supports CD) selections by viewing cover art, titles, info, results, media, and disc list.
  - USB Driver or USB drive—Store a variety of media and access it from one of these USB-connected devices.
  - MP3, WMA, AAC, or FLAC on digital audio player—Store MP3/HDD music cover art, albums, artist ratings, and genres.

- **Broadcast Media**
  - DIRECTV—View DIRECTV channel options, including station IDs, genres, ratings, and music channels.
  - Dish Network—View Dish Network channel options, including station IDs, genres, ratings, and music channels.
  - Cable TV—View cable TV channel options, including station IDs, genres, ratings, and music channels.
  - UHF/VHF—View UHF channel options, including station IDs, genres, ratings, and HDTV.
  - AM/FM/XM and Internet radio—Scan AM, FM, Internet radio, and XM stations.

2. Select any source device to modify the media list for that device.
   - Scan for new music on your network devices (configured USB-attached storage device or configured network file storage).
   - Scan for a new DVD in a configured Sony disc changer.
   - Search for media information using the media lookup service.
• Manually customize your MP3, WMA, MP4, FLAC, or AAC-formatted albums and songs.
• Manually add, edit, or delete DVD information.
• Search for the channel lineup on cable, satellite, or off-air programming service. Manually edit channel lineup.
• Create playlists. (Playlists have a limit of 500 songs.)
• Export media lists for backup purposes or import media lists.
• Export playlists for backup purposes or import playlists.
• Set up Internet radio (your dealer can do this for you).

3 To add new MP3/WMA/MP4 files to your collection, copy the files to a configured storage location on your USB-attached storage device or a configured network storage device.

4 To add a new storage device, have your Control4 Dealer add it to the Composer project and configure it for your use.
• The network address of the controller used for your MP3/WMA/MP4 files is \<ipaddress>\media\audio where <ipaddress> is your controller’s TCP/IP address (for example, 192.168.0.100). To copy MP3/WMA/MP4 files from your PC to the controller, open that folder in Windows Explorer and copy the files to a folder in that location.
• After you copy the files, use the Media view to select the storage device, and then click Scan to add them to your media list.
• Customize, if necessary, the metadata for the newly added media.

Use intelligent agents (Agents view)

Agents are modules that let you program complex tasks by using simple, pre-built functions. For example, the Scheduler agent lets you program an action using dates and times.

Agents view:
To use the Agents view:

1. Click the Agents view.

Configurable agents:

- **4Store**—Set up and manage 4Store logins, apps, themes, and storage.
- **Access**—Show or hide icons on your Navigators using a pass code.
- **Advanced Lighting Scenes**—Control lighting throughout your residence or business from any device—on-screen Navigators, touch screens, and tablets.
- **Announcements**—Create an announcement to display on the touch screens, Control4 apps, or on-screen Navigators.
- **Communication**—Sets up the Intercom system and configures Intercom groups. Required in place of Intercom agent if using any TS3 Touch Screens. Supports other Intercom-enabled devices as well.
- **Custom Buttons**—Shown on the Navigators. You can create up to four screens with six buttons each to show on the Navigators in specific rooms or in all rooms in the system. Use programming to link the Custom Button events to the actions you’d like to perform.
- **E-mail Notification**—Send email to any Internet mail address. Use programming (requires a 4Sight subscription and remote access enabled on the controller) to send out the notification.

Notes:

Remote Access is required to use the E-mail Notification agent. Check with your dealer for details about using Remote Access.

Avoid setting up email notifications for events that occur frequently (for example, when a motion sensor detects motion). If the email notification trigger event occurs too often, it will cause the system to become sluggish.

- **Intercom**—Sets up the Intercom system for 5” or 7” In-Wall Touch Screens, the 7” In-Wall Touch Screen with Camera, 7” Portable Touch Screen with Camera, or the Door Stations.

  *Note: If using any T3 Touch Screens, the Communication agent must be used in place of the Intercom agent.*

- **Light Properties**—Used for Panelized Lighting. Check with your dealer for details.
- **Media Scenes**—Create and configure media scenes which are used to link rooms in your system for audio functionality. Activate and deactivate media scenes using the Agents or Programming views.
- **Notification**—Send push notifications to mobile devices. Use programming (requires a 4Sight subscription and remote access enabled on the controller) to send out the notification.
- **Scheduler**—Schedule events to which you can attach programming. Scheduled events can be based on specific time of day, day of week, and sunrise/sunset times.
- **Screen Saver**—Create a new screen saver to use on your touch screens and on-screen Navigators.
- **SNMP Configuration**—Manage Control4 home networks remotely. Check with your dealer for details.
- **Timer**—Create a timer to enable or disable devices at set times.
- **Variables**—Create variables to use in programming. You can create number variables (numeric), true/false variables (Boolean), and text variables (string).
• **Wakeup**—Incorporate your music selection, light level and ramp rate, and temperature control to wake you up.

See “Agent Types” in the *Composer HE User Guide* for a definition of each agent with examples.

• Options available on some agents:
  • **Add**—Lets you add agents to your system.
  • **Remove**—Lets you remove agents from your system.
  • **New**—Lets you create a new instance to customize the highlighted agent in the Agents pane (left pane). For each specific instance of an agent, you provide a unique name and customize it for the specific need.
  • **Copy**—(Lighting Scene only.) Lets you copy an existing instance of the highlighted Lighting Scene agent.
  • **Delete**—Lets you remove an existing instance of the highlighted agent.
  • **Agent Navigation pane**—Provides each agent a unique interface to set up agent information in a majority of cases for future programming in the Programming view.

See the *Composer HE User Guide* for more details.

### Program the Control4 system (Programming view)

For the Control4 system to control its devices, you need to configure the behavior of those devices to occur automatically in the Control4 system. The Programming view lets you write a programming script using Composer’s drag-and-drop or double-click functions.

**Programming view:**

![Programming view screenshot]
All programming is based on events and actions in a Control4 system. For example, if a door with a sensor opens, it is logged as an event. When an event occurs in the system, it can trigger programmed actions to take place. For example, when the bathroom door opens (event), you can program the bathroom light to turn on (action).

The Programming view consists of several panes:

- **Device Events** and **Project Tree** (top left pane)—Displays all devices that have associated events.
- **Events** (bottom left pane below the Events project tree)—Displays the available Events for the currently selected device in the Events project tree. If there are no events for that device, none are displayed.
- **Script** (center pane)—Displays the script that is associated with the currently selected event from the Events pane. Drag and drop items to rearrange the order and nest items in the Script pane.
- **Device Actions** (top right pane)—Displays all available device options (in tree form) that have associated actions you can use to write your script.
- **Actions** (bottom right pane)—Displays the selection of the **Command**, **Conditionals**, and **Loops** tabs you can select to move to the Script pane. To add an action to the script, select the action, and then double-click or drag-and-drop the **green arrow** or **blue question mark** to the Script pane.

See the **Composer HE User Guide** for more details about how to create a script.

**To use the Programming view:**

1. Click the **Programming** view. Programming actions occur based on specific events in the system to make it easy to use and powerful.

Basics concepts for programming:

- **Devices**—Each device in the system is seen from two perspectives: (1) functions that occur on the device (event) and (2) functions that can be done to/using the device (action). The Device Events pane on the left side of the Programming view shows the events for each selected device. The Device Actions pane on the right side shows the actions for each selected device. Devices include not only the physical devices on the system, but also the logical devices, for example, rooms and agents.

- **Events**—When anything occurs on the system, it is an event. Most system events can have programming attached to them. Notice the specific events that occur on each device as you select devices. For example, the Control4 Wireless Dimmer has several events associated with it: Top Button Pushed, Top Button Released, Bottom Button Pushed, Bottom Button Released, and so on. The event is the fundamental trigger used in Control4 system programming.

- **Actions**—An action is a specific task that the system can perform. Actions are also device specific. For example, you can set the Control4 Wireless Dimmer to turn on/off, toggle, go to a specific dim level and ramping rate, use custom LED colors, or force the button press/release events to happen.

- **Commands**—A command is a specific action inserted into the programming script (to the Script pane).

- **Conditionals**—Most devices can be evaluated on a conditional basis. For example, the conditionals that you can use on the Control4 Wireless Dimmer are: is the light on, is the light off, or is the light level greater than/equal to/less than/not equal to a specific level? The power of conditionals lies with your ability to use them to create programming that starts with and evaluates current conditions, and then proceeds accordingly.
• **Script**—The script is the ordered set of conditionals and commands which you associate with a specific event. Scripts appear in the Script pane as you add them. When an event occurs, the Control4 system executes the script associated with the event.

• **Variables**—You can define variables when you add the Variables agent in the Agents view. There are three types of variables you can use in programming:
  - **Numeric**—For counting up, counting down, or setting values based on a number.
  - **Boolean**—For setting and tracking true/false values. For example, when the Scheduler sunset event happens, you can set a user-defined Boolean variable called Night_Time to `true`. When the Scheduler sunrise event happens, you can set Night_Time to `false`.
  - **String**—For setting and evaluating text strings in programming. For example, you can set a user-defined string variable called Selected_Playlist equal to “Exercise Music.”

• **Room Variables**—In addition to the user-defined variables you can create, the system also has system variables attached to each room, which you can use when you program your system. Room variables are most commonly accessed as commands and conditionals from the room devices. However, a full set of room variables is also available for each room on the system.

• **Programming Control**—Use the Programming Control commands to delay or stop script execution.

**Example:** Below is an example that demonstrates some of these concepts. When you start playing a DVD in the living room, if it’s evening, you want to ramp up the lights in the room gradually to 15%. When the DVD stops or pauses, the lights automatically ramp up to 50%. When the DVD plays again, the dimmer level returns to 15%.

The following steps demonstrate how you’d create the programming for the previous example.

• There are three Events: DVD Play, DVD Stop, and DVD Pause.
• The only Conditional to check is **night time**.
• Actions are added to the Script pane by either double-clicking or dragging and dropping the Action’s arrowhead or question mark into the Script pane.
• The Commands are dimmer ramp commands.
• You can drag and drop a Command arrow on top of a Conditional question mark to “nest” (or indent) the Command.
The following examples show Stop and Play commands (notice the subtle differences in the dimmer levels). Detailed information about how to program the system is in the Composer HE User Guide.
Menu options

Use the Composer HE menu bar to perform basic file tasks, view the network tools, and view the online help.

**Menu options:**

<table>
<thead>
<tr>
<th>File</th>
<th>Tools</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring</td>
<td>System</td>
<td></td>
</tr>
</tbody>
</table>

The menu bar provides the following menus:

- **File**—Perform typical file management tasks, load a project, connect to or disconnect from the local Director, refresh the Navigators, back up the project, or exit Composer HE.

- **Tools**—View network status and account information.
  
  **Note:** Updates are not supported in Composer HE.

- **Help**—View the Composer HE Getting Started online help and Composer HE version information. Links to the Composer HE User Guide are provided in the online help.

**File**

The File menu lets you perform project file management tasks, load a backed up Composer HE project, connect to Director, refresh the Navigators (including the touch screens and on-screen Navigators), create a backup, or exit Composer HE. The file management options relate to the Composer HE project files you back up on your PC (they have a .c4p extension).

When you set up a Control4 system, you create live project configuration information on the controller that is backed up to a project file on your PC. This lists specific information about each system, including devices, connections, configuration, programming information, and media.

- **Load Project**—Loads a selected project into Composer HE. Composer HE prompts you for a backup before it clears the project configuration information, and replaces it with the selected project to load from your local drive.

- **Connect to Director**—Connects you to the selected Director if there is more than one Director in the network. Composer HE prompts you to back up your project before connecting another Director. When you connect, project configuration information from the controller appears on the Composer HE screen.

- **Cloud Management**—Manage online backups saved your system.

- **Backup to Cloud**—Creates a backup of your Control4 project and saves it to Control4 online services. Requires a valid 4Sight subscription.

- **Disconnect from Director**—Disconnects you from Director. Composer HE prompts you to back up your project before disconnecting you from the currently connected Director.

- **Back Up**—Backs up the current project to your connected PC. The first time you back up, the software prompts you for a file name and to back up any media information (recommended). When you select this option, the current project becomes an option in the File > Load Project list.
• **Back Up As**—Backs up the current project, and prompts you to enter the name of the file. Composer HE prompts you to back up any media information (recommended). When you select this option, the current project becomes an option in the File > Load Project list.

• **Refresh**—Refreshes the Composer HE screen with the current project configuration from Director.

• **Refresh Navigators**—Refreshes the Navigator screens with the current project configuration from Director.

• **Exit**—Exits Composer HE and prompts you to back up the project before the software exits and returns you to the desktop.

### Media

**Note:** The Media menu appears only when you select the Media view.

The following options are available:

• **Clear Media List**—Clears the media list associated with the highlighted device from the media database.

• **Export Media List**—Exports a media list for the selected device from your controller to your PC.

• **Import Media List**—Imports a media list from your PC to your controller.

• **Export Playlists**—Exports a playlist from your controller to your PC.

• **Import Playlists**—Imports a playlist from your PC to your controller.

• **Import DVD List from File**—Imports an Excel list of DVDs for disc changers.

• **New Playlist**—Creates a playlist of MP3, WMA, MP4, AAC, or FLAC files. The playlist is available from any touch screen or on-screen Navigator. Add albums, remove songs, re-order songs, and more. (Playlists have a limit of 500 songs.)

  **Note:** If you remove songs from a playlist, it does not remove them from the media database.

• **Delete Playlist**—Removes a playlist.

• **Rename Playlist**—Renames a playlist.

### Tools

The Tools menu lets you access some tools for checking device connection status:

• **System Diagnostics**—Helps you gather system information and helps determine if any issues encountered are configuration problems, performance issues, or potential defects. See “System Diagnostics” below.
System diagnostics

**Controller Performance tab**—View controller performance information including CPU and memory usage.

**History button**—Opens the *Director Message History*. Displays a list of current *Director Messages*, collected from the time the *System Diagnostics* window was opened.
Controller Networking tab—View controller networking information, including the network type, connection status, MAC address, IP address, Subnet mask, Gateway, DHCP status, and DNS server information.

Test Internet Connection button—Click to test the current Internet connection.
System Info tab—View System information. Click **Save To File** to save the displayed text to a file.

Help

Use the Help menu to access the online version of this Composer HE Getting Started document with Index, Glossary, and search options. Also, you can check the version of your Composer HE software and Director.

From the Help menu, you have the following options:

- **Contents**. Displays the Content tab of the Help system.
- **Index**. Displays the Index tab of the Help system.
- **About Composer**. Displays the Composer HE and Director versions.

Where to go from here

Refer to the Composer HE User Guide on the Control4 website (available as HTML or PDF). The user guide provides in-depth information about how to monitor and program your Control4 system. If you are using online help in Composer HE, links to the Composer HE User Guide are provided from the help topics.

Control4 strives to support Control4 Dealers so they can support you. If you have questions or need help beyond what is provided in these guides, please contact your Control4 Dealer.
Glossary

4Sight: An Internet service that provides a connection to the home automation system any time and from any place worldwide.

4Store: The Control4 app store where you can get applications for your system. The applications appear in the touch screens or on-screen Navigators under More > Settings.

AAC: Advanced Audio Coding—A successor to the MP3 format. A standard, lossy compression and encoding scheme for digital audio. Touts better sound quality.

agent: In Control4 programming, agents provide the ability to perform complex programming by using functional modules. There are various types of agents; for example, Announcements, E-mail Notifications, Scheduler, Advanced Lighting, and Wakeup.

Anywhere Access: In OS 2.4 and later, a feature of 4Sight that lets users access and manage their Control4 systems remotely from the web, smartphone, PC, MAC, or tablet.

action: An activity that occurs when an event prompts it to do so.

AV: Audio Video.

client: A software or hardware device that communicates to a server for feedback from the server via an application for the user.

Command: A ‘do’ statement; actions the Director communicates to a device.

Composer HE: The Control4 software you can use to configure and program a Control4 home automation system.

Composer Pro: Composer Pro is used to set up and configure Control4 devices to communicate with each other in a home automation system. The dealer uses this software to create and configure the project for the customer.

conditional: An ‘if’ statement that asks true/false questions, which are acted upon in Composer programming.

collection: Devices that are bound or linked together in Composer so they can communicate with each other.

collection: Contacts are generally used to monitor the status of something (door, window, water sensor, etc.) and can be connected through a security panel or directly using a Control4 controller or Contact/Relay Extender. Contacts connected to a Control4 controller or Contact/Relay Extender can be configured either as NC (normally closed) or NO (normally open).

Control4 app: An app that lets you manage your Control4 system from an iOS, Android, PC, or Mac device.

Control4 system: A home automation system designed and developed by Control4.

controller: The main device that makes home automation possible. There may be multiple controllers within a Control4 system. The controller that runs Director is referred to as the primary controller. The other controllers in the system are secondary controllers.

device: A component that requires a device driver; code that is used to allow the Control4 system to work with that device. Device drivers are added to the project tree in Composer by the dealer.

device driver: Every device in the Control4 system needs a corresponding device driver to control that device.

DHCP (Dynamic Host Configuration Protocol): A protocol used between a network client and a DHCP server (usually a router or access point) that dynamically assigns IP addresses from a pre-defined list to clients on a network.

Director: Each Control4 controller ships with pre-installed Director software (Linux based) embedded in the device. The Director manages the entire Control4 system, including other controllers not running Director, other Control4 products and third-party products to enable home automation and interaction between devices. Composer Pro is the software used to connect to the Director software on the controller and program the Control4 system.

DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-AV devices.

end point: The end point is the final point (device) on the defined path over which audio and/or video content is routed to a room. An example of this would be a TV or receiver.
**Ethernet**: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star network topology that allows multiple points to communicate to a single point. The Speaker Point® uses Ethernet to communicate to the Control4 controller.

**event**: A programmed instance or physical input used to trigger Composer programming.

**file format**: A format used by applications to store/read files.

**FLAC**: Supported by Control4 since software release 1.8; this is a free, open source, lossless audio codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in quality.

**gateway (router)**: Provides a means of communicating between two separate networks.

**home network**: A network installed in the customer’s home that provides an Ethernet or wireless connection so that Control4 devices can communicate with each other.

**home automation system**: The Control4 system—a line of home automation products that communicate with each other over Ethernet, WiFi, or ZigBee for a total home automation experience.

**identify**: Your Control4 Dealer or installer will identify a device to the Control4 system after they add the device driver to the project tree. This ensures that the device can communicate with the Control4 controller and Director.

**intercom**: A two-way audio and/or video communication among supported Control4 devices.

**IR (infrared light)**: Some network devices can be controlled by a wireless remote control that uses pulses of infrared light to send commands to the device.

**LCD (Liquid Crystal Display)**: A display used with some Control4 interfaces.

**LCD Navigator**: An LCD device used to control lighting, music, videos, etc., on an LCD screen.

**LED**: (Light Emitting Diode). Primarily used in dimmers, switches, and keypads, but LEDs are also used on other Control4 devices for status purposes.

**Linux**: An operating system used by several Control4 devices.

**List Navigator**: Menu options that are visible on a System Remote Control.

**live connection**: A term used in Composer Pro to indicate an actual connection to the network.

**loop**: A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers are on...”

**media database**: Media information is stored in the media database, which will permit users to view the media from the Navigators.

**MP3**: A music format that makes streaming audio available.

**MP4**: An audio and video format. Can also store images and subtitles.

**Navigator**: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc. Navigator is software that the customer interacts with using a Control4 System Remote Control, on-screen Navigator (TV screen), or touch screen.

**on-screen**: Allows you to select the in the room that controls the source for the on-screen display.

**playlist**: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or any combination of the above. Control4 playlists have a limit of 500 songs.

**Power Over Ethernet (POE)**: Network cabling that provides Ethernet connectivity and device power over a single cable. Commonly used for Control4 devices.

**primary controller**: The main device that makes home automation possible. There may be multiple controllers within a Control4 system. The controller that runs Director is referred to as the primary controller.

**programming**: A machine-readable artificial language used to express computations that can be performed by a device.

**project tree**: A tree view in Composer where the project is layered by the larger branches (Home, Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

**ramp rate**: The rate that a dimmer ramps up its voltage.

**relay**: An electrical switch that opens and closes. A relay is controlled by another electrical circuit.

**remote access**: The ability to access a device from a remote location.

**Remote System**: Connects you to the home network while working in Composer from a remote location.

**retrofit**: The ability to set up a home automation system in an existing structure or home. Compare this with new building construction.

**RJ-45 jack**: An eight-pin jack used to connect CAT5e network cables to Ethernet devices.
**router**: See gateway. Functions similar to an AP but with additional functionality for controlling the network; for example, coordinating traffic between different networks.

**secondary controller**: Other controllers in the system that do not run Director or are used as the primary controller.

**serial-controlled device**: Serial-controlled devices with an RS-232 interface and control protocol often have a higher level of controllability than IR-controlled devices. Examples of serial-controlled devices are projectors, multi-disc DVD changers, etc.

**switch**: An extension of a router that adds more Ethernet ports to support additional devices or clients on the local network.

**system event**: An action that causes another action; for example, if a projector turns on, it enables the other devices in the system that work with the projector.

**System Remote Control**: A Control4 System Remote Control is a universal solution that replaces remote controls from other manufacturers, and includes programmable buttons. This System Remote Control can access on-screen Navigators.

**touch screen**: A touch screen is a home automation system Navigator that controls the home's lighting, music, videos, and other devices on the home automation system.

**UI (user interface)**: The preferred term is Navigator. The Control4 interface used with Control4 devices to control home automation, for example, touch screens, on-screen Navigators, and devices that use Control4.

**universal remote**: Universal remote control. A third-party remote control that can be programmed to replace other remotes in the home so that only one remote is needed, replacing all others. A Control4 System Remote Control is a type of universal remote control.

**USB** (Universal Serial Bus): A connector format used with USB drives that connect to a USB port on Control4 devices.

**Virtual Connection**: A term used in Composer Pro to indicate a connection outside the network.

**WIFI**: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices “connect” to each other by transmitting and receiving signals on a specific frequency of the radio band using a wireless access point. This technology uses the star network topology. WiFi uses high-bandwidth 802.11.

**wired network**: Uses Ethernet Category 5 or 6 (CAT5 or CAT6) wiring to send and receive data between devices connected to a network.

**wireless access point**: A router extension with an antenna that communicates with WiFi devices and clients in the home. A wireless hub that connects to a wired network and distributes a wireless signal throughout the structure.

**wireless dimmer**: A Control4 dimmer that uses ZigBee. UL listed.

**wireless switch**: A Control4 switch that uses ZigBee. UL listed. Has an air gap to cut power.

**WLAN**: Wireless Local Area Network.

**WMA** (Windows Media Audio)—Audio data compression technology developed at Microsoft; an audio file format that competes with MP3.

**ZigBee**: A wireless network that uses bi-directional wireless mesh network technology to transfer messages from one device to another. Unlike a star network topology where devices can only send messages to each other by sending them first to a single central device (which then delivers the message to the recipient device), a mesh network topology allows the devices to forward messages from one device to another, thereby extending the effective range of the network. Uses low bandwidth 802.15.4. Up to 250 devices are allowed per controller, but Control4 recommends a maximum of 125.

**ZigBee Pro**: The 1.1 version of ZigBee that provides improvements in standardization by: allowing more interoperability with other Control4 devices, support for home automation profiles, and improves the scalability of multiple ZigBee access points.
Index

4Sight, 6, 10, 11
Add storage device, 22
Agents
  4Store, 23
  Access, 23
  Advanced Lighting Scenes, 23
  Announcements, 23
  Communication, 23
  Custom Buttons, 23
  E-mail Notification, 23
  Intercom, 23
  Media Scenes, 23
  Notification, 23
  Scheduler, 23
  Screen Saver, 23
  Timer, 23
  Variables, 23
  Wakeup, 24
Agents view, 17, 22
Backup, 28
  with Media, 8
Backup As, 29
Backup to Cloud, 28
Broadcast Media, 21
Clear Media List, 29
Cloud Management, 28
Composer
  exit, 16
  Composer HE changes, 7
  Composer HE interface, 5, 17
  Configure devices, 5
  Connect to a Director, 5
  Connect to Control4 system, 11
  Connect to Director, 12, 28
  Contact information, 2
  Control4 dealer, 6
  Controller Networking tab, 31
  Controller Performance History button, 30
Controller Performance tab, 30
Copy MP3 files, 22
Copyright, 2
Customize, 5
Delete Playlist, 29
Device Actions pane, 25
Device Control window, 20
Device Events pane, 25
Digital music, 5
Director, 7
  connect locally, 13
Director on Local Network, 13
Disclaimer, 2
Disconnect from Director, 28
DVD information, 22
Exit, 29
Exit Composer, 8
Export Media List, 22, 29
Export Playlists, 22, 29
File menu, 28
FLAC, 22
Getting started, 7
Glossary, 33
GNU, 2
Gracenote, 2
Grant dealer rights, 15
Hard disk space, 9
Help menu, 28
home network, 8
Home network requirements, 9
Import DVD List from File, 29
Import Media List, 29
Import Playlists, 29
Inoperable system, 7
Install Composer HE, 5
Internet connection, 9
Legal notice, 2
List View, 18
  screen, 18
Load Project, 28
Local connection, 12
media database, 8
Media view, 17, 20, 21
Menu options, 28
Monitor, 5
Monitoring view, 17, 18
MP3 files, add new, 22
MPEG, 2
Network device, 21
Network file store, 21
Network requirements, 9
New Playlist, 29
Playlists, 8, 22
Programming
  example, 26
Programm view, 17, 24
  Actions, 25
  Boolean, 26
  Commands, 25
  Conditionals, 25
  Devices, 25
  Events, 25
  Numeric, 26
  Programming Control, 26
  Room Variables, 26
  Script, 26
  String, 26
  Variables, 26
Project Tree, 19
Properties, 18
Properties page, 18
Refresh, 29
Refresh Navigators, 29
Register controller, 10
Remote connection, 12
Remote Director connection, 16
Rename Playlist, 29
Requirements, hardware and software, 9
Restrictions, 6
Scan, 22
Scan for new music, 21
Scan media, 20
Search, 21
Search for Cover Art, 20
Select Remote Account, 16
Set up playlists, 20
Sony disc changer, 21
Start Composer HE, 5
Stored Media, 21
Subscription code, 11
System Diagnostics, 29
System Info tab, 32
TCP/IP, 9
Test Internet Connection button, 31
Tools menu, 28
Undo a change, 7
USB-attached storage device, 21
Video resolution, 9
Wake up scene, 6
What’s new, 6